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Welcome & Getting Started
Creating a New Grid
Creating a Simple Dataset
o (Design - Columns)
o (Design - Column Header Groups)
View Data Grid Created




How to LogIn

go to URL: districtname.schooldata.net/connect/#/student-data-grids

The login page will be one of these examples:

OR
Enter username or email from the SIS Click Authenticate With District
» | °:::: v
: P You d to logi ith your
.NSTSG!!TQRLOM - APPLICATIONS SChOOI s:hor:)TZisESicg icnc:ijtnt.yo

INTEGRATED - CUSTOM < APPLICATIONS

Login Passwor d Reset Activate Account Unlock Account Privacy Policy

*Note: Use Reset Password option, if necessary é nnect


http://districtname.schooldata.net/v3

Site NaVIgatIOH Click the Site Navigation to start.
Click Dashboards and - |
 Distributions, then Student Data f you are already in the DD
. Grids, then Launch. bundle, click the app name

. School

Site Navigation

to open a bundle list.

| School | site Navigation

By integrating data from multiple sources, SchoolData.net offers you a clear picture of how yo ur students, or ygflir schools are progressing

toward their goals.

From this window, you can navigate to any page in your SchoolData.net appljsffons. Choose an applicatigffbundie below to start exploring

DASHBOARDS AND DISTRIBUTIONS BUNDLE

Hr| Homeroom Dashboards Dashboards and Distri...

@ Guest/ Explorer School Data Employees £ Me (1have access)

Show applications for: 4 Educators ) Parents/ Guard

APPLICATION BUNDLES

Educator
NAVIGATION ITEMS PAGE DETAILS n District Administrator Homeroom

Eoucar @ Home s {@ Dashboards
. = E—.'l | =
& l20%.
re

SchoolData.net B3 +omeroom Dashboards

Educat = 3o
ucator 7 Create New Grid e

Dashboards and Distributions

B sk indicators

\

Student Details
H
) Harre Manager

7 My Student Data Grids STUDENT DATA GRIDS
My Student Data Grids

o View data settings

B High school and Beyond

B cossoom

o§  Student Data Grids Shared with Me

This page shows you your student data grid: i
: - ft School District . .
£ student Plans =) District Data Grids Srtantimantay Risk Indicators
- Eductor by Sedent Dot Grids ata Tble - daaTal
tudent data @ Student Data Grids User ©% Data Extracts

ustomized by

3 Data Adminiirator =3 £ Schools X
Student Data Grids
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Student Data Grid Column Options

13 Categories
57 Data Sources/Sets
1,300 Data Columns

v School and District Enrollments (4)
School and District Enrollments
School and District Enroliments
| School and District Enroliments
School and District Enrollments

> Graduation(4)

Current District Enrollment

Current Year Predominant School Enroliment

Historical District Enrollments

Historical School Enroliments

Current district enroliment information for the student.
Current year school enroliment information for the student.
District entry and withdrawal details for the student.

School entry and withdrawal details for the student.

CurrentlyEnrolled,DateOfInitial USEnr.
CurrentAdvisor,CurrentGradeLevel,C
ContinuesFromPreviousEnroliment,C.

CurrentAdvisor, EnrolimentSequence

School

conNNecC

t


https://docs.google.com/spreadsheets/d/1RO-StCZOzKJbbGVPDN8zFT2XfuRtVuGP/edit?usp=sharing&ouid=102810297386012876249&rtpof=true&sd=true

Creating a Data Grid




Creating a Data Grid

Click Create New Grid in the left navigation

School mx b STARLINE yems B

@ Student Data Grids

3 EMPLOYEE: CREATE NEW DATA GRID

pm— N ot G . Enter a Name and Description
- then click Save
@ Home :

(s
B Create New Grid
i Name (requ 2
B My Student Data Grids Details ‘ Vs
Student Ds and Fs Aa ‘
o Student Data Grids Share...
Description fo]
B District Data Grids

Data table of students with Ds and Fs in the last Semester /
®® Data Extracts

—
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Option for a Data Grid - Column Header Groups

. After clicking Save, an optional

DASHBOARDS AND DISTRIBUTIONS

S| student Data Grids

. Elementary Assessment Data Grid - Test ' @t checkbox appears: Suppress
Student Data Grid ID: 17821 | Student List ID: 2952 (Count: 10033) Display of Column Header

@ Home Details Design v/ GrOUpS WhiCh makes up the

B e Details - top row on the spreadsheet.

B My Student Data Grids //
o Student Data Grids Share... NOTE:
. o |fthe Column Header
oF o e Dessinto Group doesn’t display, it
ying out Assessment Dgy# Points in a Test Grid : . . .
: is still used for ordering

Details Name

[ District Data Grids Elementary Assessmept Data Grid - Tght

|
|
b T T =1 l
Name Assessments Credit | 1
| | Last First Middle ~|SBA ELA 22-23 Level -T|SBA ELA 22-23 Score |*|SBA ELA 22-2 v |Current ElrndI | : a n d grou pl ng
| 3:3322:5 Well Below hﬁg :g ig':g | :
e | - N T | . .
| | . e May bereturned to later.
| . | :
I O ptlon Checked | S‘uppress Display of Column Header Groups
: Js-,génitl{s!ﬂiﬂa |~|SBA ELA 22-23 Level ;‘" S;%EEQB;&QQ,' %IMJLJBJ:L" f;;;ﬂlglrj |
Student 4 [Well Below 2412 No [24.50 |
|

_———— e ——
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Creating a Dataset
Design Columns



Adding a Dataset - Flrst example: Identifiers (IDs)

.......................................................................................................

Dataset Sample @it

® EDUCATOR: CONFIGURE STUDENT DATA GRID

Details

Columns

>

Dataset

Student Data Grid ID: 19259 | Student List ID: 2196 (Count: 9876)

Design ™~

Columns

Column Header Groups

Ordinal

Data Source Category

e Click onthe Design tab and choose
Columns.

e Click Add Dataset.

e Expand the category choice by clicking
the arrow to the left.

e Click an Identifier checkbox.

‘@Jemographms )

Demographics

Demographics

Demographics

Demographics

Demographics

Essentials Peripherals

Data Source Description

Name The Student name in various options
Demographics Demographics information about the student
Family Family information for the student

Contact Information Contact information for the student
Identifiers Common identifiers the students

202
-
Students
9,876
Collaborate v
Add Dataset | ¢ B V=
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Configure Student Data Grid Dataset - Detail

Tab e Click the Column field and choose one or more checkboxes then click Accept.
e Click Save and close the window to return to the Design page.

EDUCATOR: CONFIGURE STUDENT DATA GRID DATASET

= Identifiers & Q@

Student Data Grid ID: 19259; Data Set ID: 2805; Data Source ID: 7

Data Source Colum: Description |
Details |
,,,,,,,,,,,,,,,,, :
State Student Identifi I
it Alter I
Essentials Label (optional) i P . I
Identifiers |
Define the label and a default category group. I
~
S |
< pager > perpage |
p
Q View Selected |
Columns Columns (Datasource / Da(‘a;eéo\umns) |
—rr e >
Select the columns to include in the data grid. I

—>

School
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More Examples: Grade Level, School etc.

. o Fromthe Design page, click Add
e T ey Dataset (not shown)

|
: ‘I v School and District Enrollments (4) I
| O T — . e Expand the category of School and
| I O School and District Enrollments Current Year Predominant School Enroliment Current year school enrollment information for the student. I 3 Di i
strict Enrollments
: ] School and District Enrollments Historical District Enrollments District entry and withdrawal details for the student. °
I O School and District Enrollments Historical School Enrollments School entry and withdrawal detais for the student. ° eckmar u
| Checkmark Current Year
I 1to130f 13 1K < pager > I .
Predominant School Enroliment
: Selected:0 Q View Selected r m I n n n r m n
| e
| |
| —— 3
R R R R R RNy e, ____ Y __________
Essentials Label (optional) @ Default Column Header Group (optional) @ !
Current Year Predominant School Enrollment Aa Current Year Predominant School Enrollment X [}
Define the label and a default category group. /

source / DataSet Columns) @

e On the next screen (not shown), e
le in the data grid. m
checkbox selections in the
Columns field and click Accept.

LLLLL

—

e Click Save and close the window —

to return to the Design page. o



Clone a Data Set

=

EDUCATOR: CONFIGURE STUDENT DATA GRID

Dataset Sample @i

Student Data Grid ID: 19259 | Student List ID: 2 (Count: 9888)

Details Design v
Columns
> Dataset
> Identifiers - 1 Identifiers
> Identifiers - 2 2 Identifiers - 2
> Current Year Predominant... 3 Current Year Predominant...
> Assessments - 4 4 Assessments
> Class Term Grades - 5 5 Class Term Grades

Default Column Hea.

Identifiers

Identifiers (2)

Current Year Predominant...

Assessments

Class Term Grades

Click Row Action Gear and choose Clone Dataset

NOTE: Column Header Groups can not be
duplicated. Will be amended with a number

students & &3
9,888

v

View Collaborate v Deliveries
i
DAddDataset & BVELRACOR ©
Row Actions

Row Actions and Options

connect



Blank or Formula Column

EDUCATOR: CONFIGURE STUDENT DATA GRID

Dataset Sample @

Student Data Grid ID: 19259 | Student List ID: 2 (Count: 9888)

Details Design v
Columns
> Dataset Ordinal Label
IIII entiters -1 : entiers
Data Source Colum_ __ __ __ Type Header Titl
| Type

State Student Identifie|
Select the type of special column to add.

Default Column Hea

Identifiers

Sort Index
Column Type (required)

Blank Column

Column Heading (optional)

Click Add Blank/Formula Column

Sort Direction

Blank Column (e.g. Placeholder for when
someone downloads the file)

Formula Column (e.g. Enter in a formula to
be used when the file is downloaded into
an Excel spreadsheet)

D AddDataset ¢ BVELRZLCOIR @&

Row Actions

?

Add Blank/Formula Column J & BV, R Z COIR &

/ Actions
Column Letter Column Hea#éer Gro... Row Actions

connect



Creating a Dataset
Design Column Header Groups



Design Tab - Column Header Groups

EDUCATOR: CONFIGURE STUDENT DATA GRID

DatasetSampIe @ Edit S b Stg‘gg“s g’j@

Student Data Grid ID: 19259 | Student List ID: 2 (Count: 9883)

. @ Click the Design tab and choose >
| Design ~ | :

Details Collaborate v Deliveries

; Column Header Groups :
ctemestiors [ a— o Click Add Record | "
: . . . \ D AddRecord | DELRAZCODR &
e Click Row Action Gear to Edit or

Column Header Group - N Actions

Remove

Column Group Name Column Header Group Label Categorv; style Row Actions

R TrTeT— TP

Demographics Demographics Default Category Group

Identifiers - 3 Identifiers - 3 Default Category Group

Current School Year Distric... Current School Year District Daily Attendance Default Category Group

Identifiers - 2 Identifiers - 2 Default Category Group Row Actions and Options

Name -2 Name -2 Default Category Group 2 E

Current School Year Schoo... Current School Year School Daily Attendance Default Category Group O Remove

Sample Name sample Label Default Category Group ’

connect



Design Tab - Column Header Groups

e Fillin the Column Group Name and Label
e Select the Export Style and Format
e Click Save and close the window

@ EDUCATOR: CONFIGURE STUDENT DATA GRID

F| Dataset Sample @t

Student Data Grid ID: 19259 | Student List ID: 2 (Count: 9883)

I Column Group Name @ Column Group Label @ I

Sample Name ﬂ/ Sample Label Aa I

Details Design Vv
g Export Style (of @ Export Data Format @

‘ Default Category Group X ®\ ‘ [ Numerical Month/Day/Year, 2 digit year ~ X @\] I

|
!__Z___ ________________ -

@ AddRecord I PVELRACIR ©

Column Header Groups

< Filtered

Column Header Group Actions

Vsd i

Column Group Name Column Header Group Label Category Style Override Column Heading Style Row Actions
Sample
Sample Name Sample Label Default Category Group @

connect



View Data Grid Created




View Data Points

| EDUCATOR: CONFIGURE STUDENT DATA GRID
clementary ASSessme t  Bedi
Student Data Grid ID: 17820 | Student List ID: 2 (Count: 9911

S .
]
]

Click the View tab
Review set-up
Return to the
Design page to
edit or add
additional data
points

-hool



Dataset Tables C.OlumnS: Dataset: .........................................

In cell editing

e Column Header Titles can be e Click the Row Action
relabeled Gear to Configure,

EDUCATOR: CONFIGURE STUDENT DATA GRID

=|| Dataset Sample @« : . . o
z Student Data Grid ID: 1925 ] Studen(EList ID: 2196 (Count: 9876) . O rd e r/D I rect I O n th e CO | u m ns C I o ne’ De I ete

Details Design ~ . @ Click the Row Action Gear to Edit, w T  otaborate~ T o veries
Columns Conﬁgu re, Remove :

=

. 2
CO|UmnS Column Header Groups : : © @
BDAddDataset ¢ AVELRACIIR &
> Dataset Ordinal Label Default Column Hea. w Actions

@ Current Year Predominant... 2 Current Year Predominanf... Current Year Predominant...

Column Actions

Data Source Colum Type Header Title Sort Index Sort Direction Column Letter Column Header Gro... Row Actions

Current School Year Data Point Current School Year asc B Current Year Predominant ...

Current Grade Level Data Point Current Grade Level desc { Current Year Predominant ... @

connect



Changing the Students in View

In the View tab:
Click the Edit Page Data Settings button

Or click the Students button

Filter and Sort

3 & EDUCATOR: CONFIGURE STUDENT
| Dataset Sample i@e«m L

Student Data Grid ID: 19259 | Student List ID: 2 (Count} 9883)

Details Design Vv
View
€ Ordered
Identifiers Current Year Predominant School Enrollment
State Student Identi... Current Grade Level Current School Year

Page Settings: Elementary Assessment Data Grid - Test

District

o NOTE: Changes DO NOT affect the column setup.

View

Student Filters

Student Groups

Stud-ents ij @
9,883

Collaborate v Deliveries

R
dRESRCOB B

School

NnNeckt



QUESTIONS

WHAT ARE YOU HOPING TO DO WE HAVEN'T
YET COVERED?

oooooo




